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EXPERIMENT V 

ELECTRONIC SPECTRA OF CHARGE TRANSFER COMPLEXES 

1. Purpose 
In the present experiment, the charge transfer (CT) absorption spectra of a series of 
electron donor (Lewis base) mixed with a same common electron acceptor (Lewis acid) 
will be recorded.  From these measurements, the extinction coefficient and the 
equilibrium constant corresponding to the CT complex can be obtained.  The results 
will be interpreted using Mulliken’s theory. 

2. Pre-Lab Preparation 
Be sure to work out in advance how to prepare the series of solutions needed for this 
experiment (see Table 1 and 2 and experimental section). 

3. Safety 
The samples prepared in this experiment consist of either organic solvents (benzene and 
substituted benzene) or solutions of organic material in heptane.  Minimize inhalation 
of these substances by preparing the samples under the fume extractor or in a fume 
hood and keeping the sample containers covered during the experiment.  

4. Introduction 
When certain substances are mixed, although no chemical reaction occurs, an 
absorption band, not present in the spectra of either of the pure compound, may appear 
in the UV/VIS region.  For example, solutions of iodine in benzene have a very strong 
absorption band at 297 nm.  This absorption band has been interpreted as the result of 
a molecule of benzene acting as an electron donor and interacting strongly with the 
electron acceptor, iodine.  In this particular case the electronic excited state can be 
viewed as the pair C6H6

+ and I2– produced by a π–electron transfer from the benzene to 
the iodine. 

Of course, this phenomenon is not general and special energetic conditions have to 
be fulfilled for this type of interaction to occur between a pair of molecules.  Using 
quantum mechanical language, for strong charge transfer interaction, the donor and 
acceptor molecular orbitals must be very close in energy and there must a large orbital 
overlap; in other words, the geometry of the two partners must allow for such an 
overlap.  Typically, these conditions are fulfilled when high energy orbitals from a 
donor interact with low energy empty orbitals from the acceptor. 

The experimental quantity easily obtained is the frequency of the CT absorption 
band, ~νCT .  One finds that ~νCT  is correlated to the electron affinity of the acceptor 
molecule, EA and to the ionisation potential of the donor molecule, Ib.  Furthermore, if 
one looks at a series of molecular complexes (i.e., varying Ib ) for which the acceptor is 
the same (i.e., EA constant), ~νCT  and ∆G0 show each a simple dependence on Ib. 
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The purpose of the present experiment will be to collect and interpret the UV/VIS 

spectra of the molecular complexes formed between a series of methylbenzenes 
(electron donors) and a same common electron acceptor, tetracyanoethylene (TCNE)  

5. Theory 
All the details of the theoretical derivation which follows can be found in Ref. [1 – 3].  
Only the main points are presented here.  However, a complete grasp of the derivation 
is not essential in interpreting the results which can be understood with semi–intuitive 
arguments. 

Mulliken’s theory attempts to deal with the formation of molecular complexes both 
inorganic or organic; in general, such species would be the result of interaction between 
a Lewis acid A (electron acceptor) and a Lewis base B (electron donor).  The formation 
of the weak complex AB, 

A  +  B  →  AB (1) 

is due to attractive dipole and polarization forces between the two molecules.  Note 
that, in principle it is possible that higher order complexes be formed (more than two 
molecules), but only 1:1 complexes will be considered here.  Also, it will be assumed 
that all the valence electrons are paired up in A and B and therefore not available to 
form a covalent bond between A and B.   

Let ψ(A,B) be the wave-function for the molecular structure AB arising from the 
weak dipole and polarization interactions.  The nature of the partners in the formation 
of the complex (electron donor/acceptor) gives rise to an ionic contribution in the 
bonding which can be viewed as A−–B+; let ψ(A− B+) be the wave-function for this 
resonance structure*

|ψG〉 =  a |ψ(A,B)〉  +  b |ψ(A− B+)〉 (2) 

.  Using the above two resonance structures as a basis set, the wave-
function corresponding to the ground state of the complex is expressed as: 

Using standard quantum mechanical formalism, EG the ground state energy is 
written: 

EG  =  〈ψG |H|ψG〉 (3) 

where H is the exact Hamiltonian operator including nuclei and electrons for both 
molecules of the complex and with the extra condition that ψG be normalized, i.e.,  

〈ψG |ψG〉  =  1  =  a2  +  b2  +  2abS   (4) 

where S, the overlap integral is: 

S  =  〈ψ(A,B)|ψ(A− B+)〉   (5) 

Simple substitution of Eq. 2 and 4 into Eq. 3 leads to one expression for EG: 

                                                 
* Note that the contribution from the other resonance structure A+–B− can be safely taken as negligible since the 

molecule A was chosen to have a much greater electron affinity than B. 
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where E0 and E1 are the energies corresponding to the pure states AB and  
A−–B+ respectively, and H01 the mixing energy: 

E0  =  〈ψ(A,B)|H|ψ(A,B)〉 (7) 

E1  =  〈ψ(A− B+)|H|ψ(A− B+)〉 (8) 

H01  =  〈ψ(A,B)|H|ψ(A− B+)〉 (9) 

Now the aim is to express EG and the parameters a and b as a function of these three 
energies which in principle can be “easily” calculated since they correspond to ideal 
pure states.  Using the variational principle[3] which states that EG must be a minimum 
with respect to variable a and b, Eq. 6 must satisfy the conditions: 

∂
∂

∂
∂
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E
b

G G= = 0  (10) 

which results in having to solve the following equations: 

a(E0 – EG)  +  b(H01 – EGS)  =  0 (11a) 

a(H01 – EGS)  +  b(E1 – EG)  =  0 (11b) 

These two simultaneous linear equations can have solutions (other than the trivial 
solution a = b = 0) only if the associated determinant is zero, i.e.: 

(E0 – EG)(E1 – EG)  –  (H01 – EGS)2  =  0 (12) 

At this stage, one should notice that the resonance form AB is the major contribution 
to the ground state of the molecular complex, which implies that ψG  ≈  ψ(A,B) (i.e., 
|a| >> |b| in Eq. 2) and  EG  ≈  E0.  Then, by substituting E0 for EG (except in E0 – 
EG) one obtains an approximate expression for EG: 
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01 0

2
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 (13) 

and from Eq. 11, a relationship between a and b 

b
a
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−
−

01 0

1 0
 (14) 

Now for the electronic excited state whose energy E* will be approximately E1 and 
which represents mostly the dative resonance form, A−–B+, using the same basis set as 
before, the corresponding wave-function is written as 

|ψ∗〉  =  a* |ψ(A,B) 〉  +  b* |ψ(A− B+)〉 (15) 

where ψ∗  ≈  ψ(A− B+)  (or |a*| << |b*|).   
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The same derivation as for the ground state can be applied to the excited state  and one 
gets readily: 
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and 
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Comparing Eq. 14 and 17 and providing that the value of the overlap S is small, the 
following is true: 

b
a

a
b

≈ −
*

*  (18) 

 
This last equation verifies that the assumptions made lead to internally consistent 

results; the ground state wave-function has mostly ψ(A,B) character while in the excited 
state, the dominant term is ψ(A− B+).  In this context, it is justified to regard the 
transition from the ground state to the excited state as a transfer of an electron from B 
to A resulting in a charge transfer spectrum.  The energy of the transition is given by (using 
cm–1 unit): 

( ) ( )~ *ν CT Ghc
E E

hc
E E= − ≈ − +

1  1
1 0 δ  (19) 

where the small correction term δ can be explicitly written (see Eq. 13 and 16): 
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To introduce into Eq. 19 molecular parameters readily available, it is convenient to 
break down the charge transfer process into the following elementary steps: 
 

AB → A + B –E0 dissociation of complex 

A + e− → A− –EA electron affinity of the Lewis acid 

B → B+ + e− Ib ionisation potential of the Lewis base 

A− + B+ → A−B+ −e2/rAB + C’AB Coulomb interaction + other 

A,B → A−B+ (E1 − E0) Charge transfer energy 
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Therefore: 

(E1 − E0) ≈ Ib – EA – e2/rAB + CAB (21) 

where CAB = C’AB – E0 represents the difference between all additional energy terms in 
the dative and no–bond resonance forms.  Eq. 19 and 21 allow us to relate the 
experimentally observable transition energy to the ionisation potential of the electron 
donor 

( )~ν CT hc
I P≈ −

1
b  (22) 

where  P = EA + e2/rAB – CAB is nearly constant for a series of complexes having a 
common acceptor since EA is constant while the other two terms are not expected to 
change significantly providing  there are no unusual steric effects in the series. 

For condensed systems like the ones under consideration, the energy terms can be 
identified with enthalpy terms, which in turn, vary linearly with the standard free energy 
for the present set of complexes[2].  Going back to Eq. 13 and 21, and identifying ∆G0 
with EG, one can relate ∆G0 to Ib according to: 

∆G M Q
I P

0 ≈ −
−b

 (23) 

where M and Q are constants.  The right–hand side of Eq. 23 represents a hyperbola 
which over a limited region is practically linear. 

Finally, the standard free energy is related to the equilibrium constant of the complex 
(an experimentally accessible parameter) through the expression 

∆G0  =  −RT lnK (24) 

6. Practical considerations 
The energy of the CT band due to complex formation is given by Eq. 22.  The exact 
location of this band will depend obviously on Ib and EA; in particular, if the electron 
acceptor has a low electron affinity while the electron donor has high ionisation 
potential, the CT band may well be located into the UV region where it would interfere 
with other absorption bands making it impossible to observe.  For the series of 
complexes used in the present experiment, the CT band shows up in the visible and is 
easily identified to measure the corresponding absorbance with a spectrophotometer.  
At the desired wavelength, Beer–Lambert’s law relates the concentration to the 
absorbance (or optical density, OD) at wavelength λ according to: 

ODλ  =  ελcl (25) 

where ελ is the molar extinction coefficient at the particular wavelength, c the 
concentration and l the path length of light through the absorbing medium.  For the 
present solution, at the maximum of absorption in the CT band, Eq. 26 takes the form: 
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Let [A]0 and [B]0 be the known nominal concentrations of A and B when the mixture 
is prepared.  One must have: 

[A]0  =  [A] + [AB] and (27) 

[B]0  =  [B] + [AB] (28) 

In addition, species A, B and the CT complex AB are in equilibrium with equilibrium 
constant: 

[ ]
[ ][ ]

K =
AB

A B
 (29) 

in which concentrations are taken to be equal to activities. 
Of all these quantities, ODmax, the absorbance of the CT complex solution is 

measured experimentally and εA and εB can be obtained from an absorption spectrum of 
the pure substances†

[AB]  =  K[A][B] ≈ K ([A]0 – [AB]) [B]0 (30) 

.  An extra simplification comes from the fact that in general one of 
the component is in large excess – say B – such that [B]0 >> [A]0  and therefore 
[B] ≈ [B]0 .  Equation 25 can be solved for [AB] using this last assumption: 

and after re-arrangement 

[ ] [ ] [ ]
[ ]
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A B

1 B
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+
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Substitution of Eq. 31 into 26, neglecting εA and εB and re-arrangement leads to: 
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Taking the reciprocal of both sides of Eq. 32, one gets an equation of the form: 

[ ]
U s i= +

1

0
B

 (33a) 

where [ ]
U

l
OD

=
A

max

0  , with s
K

=
1

ABε
  and  i =

1

ABε
 (33b) 

 

                                                 
† Actually in the present case, the various pure substances used have negligible absorption in the region of interest 

and one can take εA  =  εB  ≈ 0. 
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Eq. 33a shows that a plot of U versus 1/[B]0 should be linear where the slope is s and 
the intercept  is i.  Then from the definitions of s and i, the equilibrium constant and the 
molar extinction coefficient of the complex can be obtained: 

K i
s

=   and  ε AB
1

=
i

 (34) 

7. Procedure, data collection and analysis. 
The visible spectrum of complexes of benzene and methyl-substituted benzenes - 
toluene, o-xylene, mesitylene, hexamethylbenzene (HMB) - as electron donor with the 
same electron acceptor (TCNE) will be recorded using a HP-8453 spectrophotometer to 
measure the absorbance of the CT band.  Then, following Eq. 33, the equilibrium 
constant K and εAB will be obtained for two of the methylbenzene (the ones for which the 
equilibrium constant is not listed in Table 3).  Next, using Eq. 24, ∆G0 will be calculated so 
that the relationship between ∆G0 and Ib can be determined..  Relevant data are 
provided (see Table 3) to explore the validity of Eq. 22 and 23. 

7.1. SOLUTION PREPARATION 
All solutions are to be prepared in reasonably pure and water–free n–heptane; the 
HPLC grade is sufficient for the present purpose‡

 
.   

Important!! In the following, make sure that all the volumetric flasks are dry as trace of water will 
invalidate the results.  Rinse the flasks with some acetone, shake dry then air dry. 
 

Table 1. Suggested amounts to prepare stock solutions of donor/acceptor complex 
("B1" solutions). 

Donor ID Volume donor Volume sol. A Final volume 
Benzene 2 mL 8 mL 10 mL 
Toluene 2 mL 8 mL 10 mL 
o-Xylene 2 mL 8 mL 10 mL 

Mesitylene 2 mL 8 mL 10 mL 
HexaMethylBenzene (HMB) 20 mg 10 mL 10 mL 

 

7.1.1 TCNE stock solution 

To prepare 200 mL of a ≈ 10−4 M solution in n-heptane, weigh no more than 3 mg TCNE; 
use the special glass boat provided to do the weighing on the analytical balance and to 
transfer quantitatively this small amount into the volumetric flask.  TCNE is not very 

                                                 
‡ For very precise work, care should be taken to remove dissolved oxygen which interferes to some extent with 

complex formation; this can be done by bubbling dry nitrogen through all the solutions.  However, for the series of 
complexes under study here, good results can be obtained without this extra, time–consuming manipulation. 
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soluble in heptane.  First, pour heptane solvent into the volumetric flask only to 1/2 , 3/4 full, next 
immerse the flask for 5 - 10 minutes in a sonicator bath (until all the TCNE has dissolved), and 
finally fill the flask to the mark with heptane.  This is your TCNE stock solution (solution A). 

7.1.2 Stock solutions of the methylbenzene/TCNE complex. 
Next, five solutions (B series stock solutions), each corresponding to one of the 
methylbenzene/TCNE complex can be prepared as suggested in Table 1.  Two 5 mL 
syringes are provided for volume measurements. 
 

Please be careful to avoid cross–contaminating the compound storage bottles, and make sure that all 
the volumetric flasks are dry (trace of water in the solutions will invalidate the results). 

 
Finally, for each of the two selected methyl benzene (for this term – Spring 2013 – toluene 
and hexamethylbenzene) two sets of four further dilutions (set "B2" to "B5" solutions) are 
prepared following Table 2. 
In total, one should end up with thirteen donor/acceptor solutions. 
 

Table 2. Suggested amounts necessary to prepare a series of dilutions of donor/acceptor. 

Solution ID Volume sol. B* Volume sol. A Final volume 
Stock solution B1 see Table 1 10 mL 

Solution B2 4 mL B1 6 mL 10 mL 
Solution B3 2 mL B1 8 mL 10 mL 
Solution B4 3 mL B2 7 mL 10 mL 
Solution B5 1 mL B2 9 mL 10 mL 

* Here, "B" stands first for the toluene, then for the hexamethylbenzene series of solutions 

7.2. UV/VIS SPECTRA 
All spectra will be recorded in a quartz cell will an optical path of 1 cm using the HP–
8453 spectrophotometer.  This instrument is driven by a PC through a proprietary 
interface.  The instructor will demonstrate the operation of this instrument. 
Once the HP software has been loaded, load the proper ”Method” (File -> Load Methods 
-> choose CTEXPT.M in the directory C:\366).  A pop-up window will come up, asking 
whether you want to change the light source configuration; verify that the tungsten 
lamp is ON and the deuterium lamp OFF; if necessary, click ON/OFF the appropriate 
tags, then accept the lamp configuration.   
Check the scanning range (Instrument -> Setup Spectrophotometer); set a range of 300 to 
750 nm, Integration time of 5 s and Interval 1 nm. 
If not already set, you can alter the lamps setting (Instrument -> Lamps): select tungsten 
lamp ON and deuterium lamp OFF. 
Under Method, click on Spectrum/Peak. 
To check overall status,. Instrument -> Spectrophotometer Status.  
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To avoid wasting valuable solution and to make sure that the cuvette is not contaminated with the 
previous left over solution, it is highly recommended to rinse each time the cuvette at least three times 
with some acetone, then air dry it.  In this way, the cuvette is dry for the solution to be measured to be 
poured in directly without pre-rinsing and thus resulting in a minimum of waste solution. 

 
Record first between 300 nm to 750 nm a spectrum of the pure solvent which will be 

used as your blank (Measure -> Blank).  Next, in the same wavelength range obtain a 
spectrum of each of the solution B1 (Measure -> Sample), then a spectrum of each of 
the various donor/acceptor dilutions prepared; make sure the button "Overlay Spectra" 
has been activated.  Save your spectra (File -> Save -> Samples as).  From each 
spectrum, record the λmax of the charge-transfer band and the corresponding 
absorbance.  To clear saved spectra from display Edit -> Clear -> Samples.  To recall 
saved files: File -> Load -> Samples. 

Note: be careful with the software; although the machine is supposed to find the 
maximum absorbance of your spectrum, for some unknown reason, it fails miserably 
sometimes, and reports a nonsensical maximum wavelength.  Check visually if the 
maximum reported by the machine makes sense; if not, with the mouse pointer, point to 
your spectrum, and then click using the mouse right

Obtain a printout of your spectra (File -> Print -> Selected Window).  If the absorbance 
reported by the instrument is negative (which has no physical meaning), or the different 
spectra do not appear to have a common baseline, you will have to extract the 
absorbance values directly from the plot by measuring the height of the peak relative to 
its wings.  This is illustrated in fig. 1. 

 button.  A black arrow pointer 
should appear which can be moved up and down the spectrum while the corresponding 
wavelength and absorbance are displayed at the bottom of the screen. In this way find 
the relevant maximum optical absorbance and the corresponding wavelength and record 
these numbers in your note book.  

 
Please, enter the required information into the instrument log–book before leaving the lab. 

7.3. DATA ANALYSIS 
For each mixture donor/acceptor, calculate the prepared concentrations [A]0 and 
[B]0.(careful with this calculation; work out first the actual number of moles of A and B 
which are going into the dilution).  Tabulate for each complex and for each series of 
concentration, the λmax, the ODmax and the corresponding concentrations [A]0 and [B]0.  
Convert the wavelength to cm-1. 

With the appropriate plot and fit, verify that Eq. 22 is satisfied (or otherwise) with 
the expected slope (see Table 3 for values of relevant ionisation potentials). 

From the series of spectra recorded at different concentrations of the complex, 
obtain the formation equilibrium constant and the extinction coefficient of the CT 
complex following Eq. 33 and 34; perform this determination at λmax. 
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Fig. 1. Method to measure graphically the maximum absorbance relative to a 

reconstructed baseline when a baseline shift has occurred between successive 
spectra.  Spectra (1), (2) and (3) were supposed to have a common baseline; 
the graph shows how to estimate in each case the baseline, and then to obtain 
the relevant absorbance, labelled OD(i) in the diagram. 

Calculate ∆G0 from the equilibrium constants obtained and check the correlation 
between ∆G0 and Ib (for the equilibrium constants not measured, use the data provided 
in Table 3).  Is the expected variation observed? 

Comment on the validity of the model used to account for these data.  Can you think 
of other systems (donor/acceptor) which would have (or could be expected to have) 
similar behaviour as the pair TCNE/substituted benzenes? 

Table 3. Selected data for methylbenzene/TCNE complexes. 

Donor ID Ib (eV) K (M-1) 
Benzene 9.245 0.938 
Toluene 8.82 - 

o-Xylene 8.56 4.76 
Mesitylene 8.40 13.6 

HMB (Hexamethylbenzene) 7.85 - 
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